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Preface
This document gives an overview and describes the technical details for a standard installation of
the FraudOne licensing. It serves as an information and installation reference manual for the
customer’s administrator. It is by no means considered to be an educational manual which would
enable someone to understand all details of the licensing scheme.

It is intended only to give you an overview of the FraudOne licensing scheme and should enable a
system administrator to install, maintain and upgrade any license in the FraudOne system. The
target group for this documentation consists of those who carry out the administrator duties for a
running system.

Related documentation

The full documentation set for Kofax FraudOne is available at the following location:

https://docshield.kofax.com/Portal/Products/en_US/FO/4.4.2-c5l5th79bw/FO.htm

 

In addition to this guide, the documentation set includes the following items:

Guides

· Kofax FraudOne Administrator's Guide

· Kofax FraudOne Data Warehouse Installation and Operation Guide

· Kofax FraudOne Extended Reporting Features and Statistics

· Kofax FraudOne Feature Codes

· Kofax FraudOne Installation and Migration Guide

· Kofax FraudOne Java Client Customization Guide

· Kofax FraudOne Java Client Customization Layer

· Kofax FraudOne Report Component Installation Guide

· Kofax FraudOne SignCheck Result Codes

· Kofax FraudOne Standard Reporting Features and Statistics

· Kofax FraudOne The Book on CRS

· Kofax FraudOne Thin Client Customization Guide

· Kofax FraudOne Thin Client Customization Layer

Interfaces

· Kofax FraudOne Archive Interface Server

· Kofax FraudOne ASV Blackbox

· Kofax FraudOne Global Fraud Signature Web Service Developer's Guide

· Kofax FraudOne Common API Specifications for GIA Engines

· Kofax FraudOne Service Program Interfaces

· Kofax FraudOne User Login Procedure

· Kofax FraudOne Standard Teller Interface

https://docshield.kofax.com/Portal/Products/en_US/FO/4.4.2-c5l5th79bw/FO.htm
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· Kofax FraudOne Variant Cleanup Utility

Online Help

· Kofax FraudOne Administration Client Help

· Kofax FraudOne Java Client Help

· Kofax FraudOne Server Monitor Help

· Kofax FraudOne Thin Client Help

 

Training

Kofax offers both classroom and computer-based training that will help you make the most of your
FraudOne solution. Visit the Kofax website at www.kofax.com for complete details about the
available training options and schedules.

Get help for Kofax products

Kofax regularly updates the Kofax Support site with the latest information about Kofax products.

To access some resources, you must have a valid Support Agreement with an authorized Kofax
Reseller/Partner or with Kofax directly.

Use the tools that Kofax provides for researching and identifying issues. For example, use the
Kofax Support site to search for answers about messages, keywords, and product issues. To
access the Kofax Support page, go to www.kofax.com.

The Kofax Support page provides:

· Product information and release news

Click a product family, select a product, and select a version number.

· Downloadable product documentation

Click a product family, select a product, and click Documentation.

· Access to product knowledge bases

Click Knowledge Base.

· Access to the Kofax Customer Portal (for eligible customers)

Click Account Management and log in.

To optimize your use of the portal, go to the Kofax Customer Portal login page and click the
link to open the Guide to the Kofax Support Portal. This guide describes how to access the
support site, what to do before contacting the support team, how to open a new case or view
an open case, and what information to collect before opening a case.

· Access to support tools

Click Tools and select the tool to use.

· Information about the support commitment for Kofax products

Click Support Details and select Kofax Support Commitment.

Use these tools to find answers to questions that you have, to learn about new functionality, and to
research possible solutions to current issues.

http://www.kofax.com
http://www.kofax.com
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Licensing scheme overview
The FraudOne license scheme is totally based on software techniques. There is no special or
dedicated hardware, chip, dongle or other physical means required using the new license scheme.

The FraudOne license scheme supports a local license model and a network license model.
Also mixed mode is possible, but not recommended. See License models for a detailed
explanation of licensing models.

License files

The proposed scheme requires the installation of at most one license file (or license server based
equivalent) on each machine at a customer site. Only machines where the Server Manager
component or Thin Client Business Model Server (Web Server) is installed will require a hardware
bound license file. It is recommended, but not required, that the Server Manager be installed also
on Thin Client Business Model Server machines, even when it is not required to control the
operation of other server processes on that machine.

The single license file is named SignPlus2.lic. This is the only file that must be updated when
installing a 'real' FraudOne license. Also refer to the following sections regarding Demo licenses
and how to purchase a valid license file for production.

The license files use the standard SPLM2 support that ensures they are installed on a known
target machine. The number of machines where the license has been installed to ensure access
for auditing purposes will be tracked.

There is one other internally used license file, SignPlusClient2.lic, which is not hardware bound
and can be used on any machine. This license file is required by, and is installed with, the Java
Client program.

 

Location of license files

All license files must be located in a directory called lmdata. This directory must be in relative
position (subdirectory) of the directory where the license management library splm2.dll resides.
This is normally transparent to the customer since both the library and the license files are installed
correctly by the installation script(s).

In a Linux based environment, the license files must be located in a writeable and persistent
directory. This can be LMDATA (uppercase and in relative position (subdirectory) of the directory
where the license management library splm2.dll resides) or the directory can be configured
in /etc/softpro/splm2.cfg (e.g. /var/softpro).

Licensed features, components and usage limits

Since release 4.0 the single license file will not contain any component, feature or usage
information and the installed programs will not attempt to regulate the use of such features.

All features of FraudOne will be enabled in an unrestricted form by the presence of the one
FraudOne license file on the (or each) Server Manager machine(s).
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License use reporting

All purchasable FraudOne features and components will record their usage statistics in database
entries. These database entries are used to allow auditing of the usage of FraudOne by the
customer – such auditing reports are available to contracting parties.

These reports include only the actual usage of the FraudOne features and components. The
licensed features and components and the usage limits purchased by the customer are not
included in these reports. This information is shown (in a form that makes it easy to compare with
the reports) only in the customer order confirmation and delivery notes.

Access to licensed machines

Since run time checks of license usage are no longer performed they must replaced by a periodic
auditing of the usage statistics recorded by the FraudOne programs in their database. This auditing
access, guaranteed by the terms of the maintenance contract, requires that an employee of
contracting parties be able to visit, physically, each machine on which a FraudOne license is
installed and to execute commands to query the license usage for that machine.

The auditing done by an employee of contracting parties will include plausibility checks between
the information recorded during a visit and any historical information from the database. This is
necessary since we do not protect the recorded statistical information from manipulation by the
customer.

This ensures that machines cannot continue to run for more than two years following their "loss"
from the auditing program; no machines that are unavailable for auditing will be given a license
extension.

Customers will be reminder of the end of the (up to) two year license period starting at the end of
the previous calendar year – so giving customers up to a year to refresh the license. These
reminders will become more and more "noisy" as the year progresses. At the end of the second
year, the Server Manager program will no longer run on the target machine.

License models
FraudOne supports Demo licenses, local licenses and network licenses.

Demo license

Each FraudOne shipment comes with a so called Demo license. This type of license is valid for
one month and runs on any machine. This means that a newly installed system can be used with
all configured features and without any restriction immediately after installation. Since the license
expires after 30 days the customer must request a new – now hardware bound – license file and
update the current one. Information, how to request a license file, is given later in this document.

Local license

In this license model the license file is stored only locally. The only license that must be updated is
the SignPlus2.lic file.
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You will need a separate license file for each server machine where you want to run a Server
Manager and/or Thin Client Business Model Server.

The presence of the license file(s) in the correct directory (see above) is sufficient. In contrary to
the previous FraudOne releases there is need to create registry entries for the local license model.

Network license

The use of a FraudOne network license model via a license server is usually not necessary for a
single system with FraudOne. But, for installing and maintaining FraudOne server farms the usage
of the network license model may be an option in order to reduce the installation and maintenance
effort for the license files. Also the use of a backup FraudOne system requires the network license
model namely a backup license server. The local license scheme does not support backup
facilities. For the sake of having identical systems it is good practice to use a license server on a
single FraudOne system, too.

You may install the license server of the FraudOne system before you install FraudOne, however it
is recommended to install the system first and verify the correct running with the initial local license
provided prior to using the network license model.

The usage of the network license model requires two steps:

1. Installation of a license server with a valid network license

2. Enabling the Server Manager to retrieve the license from the license server

Notice that the installation of a Server Manager component is required in this case also for Thin
Client Business Model Server systems.

Detailed installation steps are described below.

Usually the license server is installed on a dedicated machine. However, it will be possible to install
it on any machine, including one of the server boxes.

Please note that, when using the network license model, the Server manager application on the
different workstation must have write access to the registry. This is also the case for the license
server. These programs must be able to write the registry in

HKEY_CLASSES_ROOT\Software\SOFTPRO\SPLM2

and all its sub-keys.

Installing and activating the local license
Each Server Manager and/or Thin Client Business Model Server installation comes with a license
key (usually contained in a license directory called lmdata). If once activated the license files
cannot be moved onto another disk or onto another machine. If this is necessary new license files
must be requested.

The initial Demo license file must be replaced by a valid hardware bound license file. In order to
provide the correct license file the hardware installation code of the machine where the license will
be used is needed. Thus, the hardware code must be delivered together with the license request.

Obtaining the correct hardware installation code

The required hardware code can be accessed by a utility named splm2view.exe. This utility is
installed together with the Server Manager.



Kofax FraudOne License Management

9

The user must switch to the installation directory and must start splm2view with the parameter
SignPlus2:

d:\signplus> splm2view.exe SignPlus2

The license viewer opens a window displaying the current settings of the FraudOne license. Among
this information you can also find the hardware installation code.

 

 

Installing the local license files

A new license file SignPlus2.lic for each machine will be provided. In order to activate the new
license it is sufficient to copy the new license file over the old one. The result can also be checked
with the license viewer again.

Considerations for other products

When a system on which FraudOne is to be installed already contains installations of other
products (for example, SignDoc) or if another product is to be installed on a system where
FraudOne is already installed, some special considerations apply.

Since the installation of some other products are done directly by the end users and may even
have occurred some considerable time in the past, it is not always possible for the installation
procedures to correctly identify the current installation locations or versions. To ensure correct
operation of all products, it is necessary to ensure two things:
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· That all existing copies of splm2.dll are replaced with the newest version. Note that the
product being installed may include an older version of splm2.dll and this should then not be
installed and the existing newer version be used in its place.

· A copy of the lmdata directory and its contents from the current FraudOne installation should
be made and should appear as a subdirectory of every directory where an splm2.dll is
installed.

 

Installing and activating the license
server
For a network license model the software must be first installed as described for the local license
usage, see chapter Installing the local license files. The following additional steps must be
performed to establish the network license model:

 

 

The installation process is described in the following two sections Installation of the license server
and Enabling the Server Manager to retrieve the license from the license server.

Installation of the license server

The license server must be installed via the install program shipped together with the FraudOne
installation. In order to install the license server you must run the installation program by starting it
either from a command prompt or by double click on the program SPLicenseServer.exe. The



Kofax FraudOne License Management

11

installation program installs Demo licenses by copying the respective files to the chosen directory
and updating the registry with the appropriate entries. This explicitly means that the user must have
write access to the Windows registry. To complete the installation please follow the instructions
given by the install program! The installer creates and launches a new software service for the
license server. The service can be maintained by the using standard Windows tools.

 

 

Now that the license server is up and running you must just replace the Demo license(s) – installed
by default – with an actual license server license. Similar to the local license installation you will
need the hardware installation code in order to request the license.

To install the license you have to start the license server console program. In the start menu
navigate to the License Server program shortcut and launch the console program. The console
window will open.
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However, you will not see any license listed yet since no license is currently activated. In order to
see all inactive licenses click the View menu and Inactive Licenses. Then you see the installed
license files.

 

 

Navigate to the Product license called SignPlus2, select the installation code and copy it into the
clipboard

Edit > Copy

The installation code is needed to require a valid license.

Once the license file has provided you must copy it onto any location different from the location of
the current license file. Open the license server console and navigate to the SignPlus2 product
license as described above. Click:
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File > Install License

A file selection dialog will appear. Select the SignPlus2-transfer.lic license file and click Open.
The license will be taken from the newly received file and inserted into the initial license file. You
will see the new license information in the control window:

You may now stop splm2control via:

File > Exit

The service splm2service is still running and will be restarted on system start.

This finishes the license server installation. The provided licenses can now be used by a FraudOne
installation.

Enabling the Server Manager to retrieve the license from
the license server

To be able to access the license server, the FraudOne installation (License Client) must be
configured to access the license server rather than the local license files. With other terms, the
Server Manager must be configured to retrieve license information from the license server. This
can be achieved by adding the following configuration entries into the Server Manager’s
configuration file srvmngr4.ini (note the British spelling of the parameters: Licence…):

LicenceServerAddress=<ip-address>
;(default none)
LicenceServerPort=<port number>
;(default 2020)
LicenceServerTimeout=<timeout in milliseconds>
; (default 2000 ms)
LicenceServerRetries=<number of retries>
; (default 2)

The Server Manager automatically generates necessary registry entries which are required for
license management. This, of course, needs write access to the registry on the machines hosting
the Server manager program.

Note Even if the server license model is used the local license files must have been installed
as described in chapter Installing the local license files.

 

Using License Server for Thin Client

When a Thin Client Business Model Server should use a license server rather than a local license,
it is then necessary to use a Server Manager process on the Web Server machine. This Server
Manager process then provides the linkage to the license server in the same way as described
above.
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